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SYMANTEC LICENSE AND WARRANTY

NOTICE: SYMANTEC LICENSES THE ENCLOSED SOFTWARE 
TO YOU ONLY UPON THE CONDITION THAT YOU ACCEPT 
ALL OF THE TERMS CONTAINED IN THIS LICENSE 
AGREEMENT.  PLEASE READ THE TERMS CAREFULLY 
BEFORE OPENING THIS PACKAGE, AS OPENING THE 
PACKAGE WILL INDICATE YOUR ASSENT TO THEM.  IF YOU 
DO NOT AGREE TO THESE TERMS, THEN SYMANTEC IS 
UNWILLING TO LICENSE THE SOFTWARE TO YOU, IN 
WHICH EVENT YOU SHOULD RETURN THE FULL PRODUCT 
WITH PROOF OF PURCHASE TO THE DEALER FROM WHOM 
IT WAS ACQUIRED WITHIN SIXTY DAYS OF PURCHASE, 
AND YOUR MONEY WILL BE REFUNDED.

LICENSE AND WARRANTY:

The software which accompanies this license (the "Software") 
is the property of Symantec or its licensors and is protected by 
copyright law. While Symantec continues to own the Software, 
you will have certain rights to use the Software after your 
acceptance of this license.  Except as may be modified by a 
license addendum which accompanies this license, your rights 
and obligations with respect to the use of this Software are as 
follows: 

You may: 

(i) use one copy of the Software on a single computer; 
(ii) make one copy of the Software for archival purposes, or 
copy the software onto the hard disk of your computer and 
retain the original for archival purposes;
(iii) use the Software on a network, provided that you have a 
licensed copy of the Software for each computer that can 
access the Software over that network;
(iv) after written notice to Symantec, transfer the Software on a 
permanent basis to another person or entity, provided that you 
retain no copies of the Software and the transferee agrees to 
the terms of this agreement; and 
(v) if a single person uses the computer on which the Software 
is installed at least 80% of the time, then after returning the 
completed product registration card which accompanies the 
Software, that person may also use the Software on a single 
home computer. 

You may not:

(i) copy the documentation which accompanies the Software;
(ii) sublicense, rent or lease any portion of the Software;
(iii) reverse engineer, decompile, disassemble, modify, 
translate, make any attempt to discover the source code of the 
Software, or create derivative works from the Software; or
(iv) use a previous version or copy of the Software after you 
have received a disk replacement set or an upgraded version 
as a replacement of the prior version, unless you donate a 
previous version of an upgraded version to a charity of your 
choice, and such charity agrees in writing that it will be the 
sole end user of the product, and that it will abide by the 
terms of this agreement.  Unless you so donate a previous 
version of an upgraded version, upon upgrading the Software, 
all copies of the prior version must be destroyed.

Sixty Day Money Back Guarantee:

If you are the original licensee of this copy of the Software and 
are dissatisfied with it for any reason, you may return the 
complete product, together with your receipt, to Symantec or 
an authorized dealer, postage prepaid, for a full refund at any 

time during the sixty day period following the delivery to you 
of the Software.

Limited Warranty:

Symantec warrants that the media on which the Software is 
distributed will be free from defects for a period of sixty (60) 
days from the date of delivery of the Software to you. Your 
sole remedy in the event of a breach of this warranty will be 
that Symantec will, at its option, replace any defective media 
returned to Symantec within the warranty period or refund the 
money you paid for the Software.  Symantec does not warrant 
that the Software will meet your requirements or that 
operation of the Software will be uninterrupted or that the 
Software will be error-free. 
THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL 
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT.  THIS WARRANTY GIVES YOU 
SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, 
WHICH VARY FROM STATE TO STATE.

Disclaimer of Damages:

REGARDLESS OF WHETHER ANY REMEDY SET FORTH 
HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT 
WILL SYMANTEC BE LIABLE TO YOU FOR ANY SPECIAL, 
CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, 
INCLUDING ANY LOST PROFITS OR LOST DATA ARISING 
OUT OF THE USE OR INABILITY TO USE THE SOFTWARE 
EVEN IF SYMANTEC HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.
SOME STATES DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION 
OR EXCLUSION MAY NOT APPLY TO YOU.
IN NO CASE SHALL SYMANTEC’S LIABILITY EXCEED THE 
PURCHASE PRICE FOR THE SOFTWARE. The disclaimers and 
limitations set forth above will apply regardless of whether 
you accept the Software.

U.S. Government Restricted Rights:

RESTRICTED RIGHTS LEGEND.  All Symantec products and 
documentation are commercial in nature.  The software and 
software documentation are “Commercial Items”, as that term 
is defined in 48 C.F.R. §2.101, consisting of “Commercial 
Computer Software” and “Commercial Computer Software 
Documentation”, as such terms are defined in 48 C.F.R. 
§252.227-7014(a)(5) and 48 C.F.R. §252.227-7014(a)(1), and 
used in 48 C.F.R. §12.212 and 48 C.F.R. 227.7202, as applicable. 
Consistent with 48 C.F.R. §12.212, 48 C.F.R. §252.227-7015, 48 
C.F.R. §227.7202 through 227.7202-4, 48 C.F.R. §52.227-14, and 
other relevant sections of the Code of Federal Regulations, as 
applicable, Symantec’s computer software and computer 
software documentation are licensed to United States 
Government end users with only those rights as granted to all 
other end users, according to the terms and conditions 
contained in this license agreement.  Manufacturer is Symantec 
Corporation, 20330 Stevens Creek Blvd., Cupertino, CA 95014. 
General:
This Agreement will be governed by the laws of the State of 
California.  This Agreement may only be modified by a license 
addendum which accompanies this license or by a written 
document which has been signed by both you and Symantec.  



Should you have any questions concerning this Agreement, or 
if you desire to contact Symantec for any reason, please write: 
Symantec Customer Sales and Service, 20330 Stevens Creek 
Blvd., Cupertino, CA 95014. 
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C H A P T E R 1Getting started

Introducing Norton Speed Disk
Norton Speed Disk for Windows NT/2000 provides powerful analysis and 
optimization tools to maintain peak performance of your hard drives. 

Using a combination of defragmentation and optimization, Norton Speed 
Disk optimizes all disk elements, including files, directories, the paging file 
(Pagefile.sys), the Master File Table (MFT), and meta data, without 
rebooting the machine. Under Windows 2000, additional system files are 
present, including a journal log for disk transactions. Norton Speed Disk 
optimizes this file when it is present. 

Optimization vs. defragmentation

The terms defragmentation and optimization are often used 
interchangeably, but they are not the same. 

� Defragmentation is the process of rearranging the way files are 
organized on a hard drive so that the data comprising each file is 
stored in contiguous disk clusters.

� Optimization maximizes the usable free space on a hard drive and 
groups files based on how they are accessed. The most frequently 
used files are placed at the beginning of the disk for fastest access. 
Infrequently used files are placed out of the way. Free space is 
consolidated to avoid fragmenting newly added files, and extra space 
is added after major data structures so they can grow without 
immediately becoming fragmented again. Optimization can drastically 
improve performance, both after initial optimization and on a 
continuing basis. 
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Norton Speed Disk technology

Norton Utilities products have a tradition of providing secure, reliable disk 
utilities. Norton Speed Disk extends this tradition with its patented 
optimization technology, cutting edge research, and quality assurance to 
produce the most reliable, effective disk optimization utility to date. 

A range of customization features let users and administrators fine-tune 
optimization based on each drive’s purpose and workload, to ensure that 
machine performance is as high as possible.

Norton Speed Disk can:

� Optimize an entire drive online, including files, directories, MFT, even 
paging files and security meta data.

� Optimize without rebooting. 

� Optimize in only one pass—even after optimizing paging files.

� Use intelligent analysis to place file types in the optimal order for best 
performance, which reduces the frequency and necessity for 
substantial re optimizations.

Some of the benefits of using Norton Speed Disk on networks include:

To do this Go here

Completely optimize all drives online, 
including the directories, MFT, paging 
file (Pagefile.sys), and meta data. 

“Running the initial optimization” 
on page 28.

See a detailed analysis of file and free 
space fragmentation, and overall drive 
utilization. 

“Analyzing drives” on page 33.

Customize optimization features such 
as file placement, use of machine 
resources and memory, and 
fragmentation threshold. 

“Customizing Norton Speed Disk” 
on page 41.

Schedule Norton Speed Disk to 
optimize drives at a set time.

“Scheduling optimizations” on 
page 41.

Record specified optimization events to 
the Windows NT/2000 Event Log.

“Recording optimization events” 
on page 48.



Introducing Norton Speed Disk

9

� Workstations and servers are optimized so they run at peak 
performance. Improved server performance means increased 
throughput for applications like groupware and databases. Less wait 
time means greater productivity.

� System (desktop and server) uptime is increased and the various 
threats associated with downtime are reduced. IS time and resources 
spent responding to performance-related, non-strategic issues (such as 
system crashes due to lack of disk space) are decreased. 

� Easy optimization management with one central management console 
(provided with Norton Speed Disk for Windows NT/2000 Server). 
Centralized scheduling and alerts let administrators view all the 
information they need from one location.

� Flexible interface design support both centralized and decentralized 
management styles.

� Built-in scheduling features minimize the amount of active 
administration time required to run and maintain Norton Speed Disk.

System requirements

The minimum system requirements are:

Machine IBM PC or compatible

CPU Intel 80486/66 processor or higher

Operating system Windows NT v. 4.0, (Workstation or Server) with 
Service Pack 3, 4, 5, 6, or Windows 2000

RAM 32 MB RAM or greater

Disk space 20 MB

File system All NTFS and FAT cluster sizes: (512 bytes, 1k, 2k, 4k, 
8k, 16k, 32k, 64k)

Drives CD-ROM drive or network connection

Monitor 16 color VGA, 256 color recommended
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Installing Norton Speed Disk
The Norton Speed Disk installation procedure lets you specify where to 
install and provides the opportunity to run LiveUpdate to check for the 
latest updates to the program.

Note: If you intend to administer Norton Speed Disk on a network, see the 
installation instructions in the Norton Speed Disk Implementation Guide 
included with Norton Speed Disk for Windows NT/2000 Server (Enterprise 
edition only).

To install Norton Speed Disk for Windows NT/2000:

1 Insert the Norton Speed Disk CD in the CD-ROM drive.

� If the installation window does not appear, open the CD and 
double-click CDSTART.EXE.

2 Click Install.

3 Proceed through the installation screens.
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During installation you have a chance to confirm the location to install 
Norton Speed Disk.

To install Norton Speed Disk to a different location, click Browse, and 
select another folder, or enter a new folder name, then click OK.

4 Select a Program Group Option:

� Group Will Be Common To All Users

Anyone who has access to the workstation can use the Norton 
Speed Disk group.

� Group Will Be A Personal Group

Only the person currently logged in can use the new Norton Speed 
Disk group.

5 Indicate if you want LiveUpdate to check for program updates after 
installation. If an update exists, LiveUpdate will download and install 
the update. You must have an Internet connection to access the 
Symantec LiveUpdate FTP server. For more information, see “Updating 
Norton Speed Disk” on page 15.

At the end of installation, Norton Speed Disk is installed to the path 
selected in step 3, for example:

c:\Program Files\Norton Speed Disk\

A menu item is also added to the workstation Start menu.
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What to do after installation

Once Norton Speed Disk is installed, you can start optimizing your drives. 

Note: (Enterprise edition only.) If during the installation process you select 
Standard Installation Without User Interface, you will not see the Norton 
Speed Disk window at all. Select this option if you plan to run Norton 
Speed Disk from a central console such as Norton System Center Console, 
which comes with Norton Speed Disk for Windows NT/2000 Server. For 
more information, see the Norton Speed Disk Implementation Guide, which 
is included with Norton Speed Disk for Windows NT/2000 Server.

Starting and quitting Norton Speed Disk
Use the following steps to start Norton Speed Disk. 

Note: You can also start Norton Speed Disk by scheduling optimization. 
For more information, see “Scheduling optimizations” on page 41.

To do this Go here

Check for program updates with 
LiveUpdate.

“Updating Norton Speed Disk” on 
page 15.

Review optimization strategies. “Deciding on an optimization strategy” 
on page 24.

Optimize for the first time. “Running the initial optimization” on 
page 28.

Optimize multiple drives at the 
same time.

“Optimizing multiple drives 
concurrently” on page 32.

Check a drive’s fragmentation level. “Analyzing drives” on page 33.

Schedule optimization times. “Scheduling optimizations” on page 41.

Set global performance options. “Setting global options” on page 45.

Customize drive optimization. “Setting drive options” on page 52.
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To start Norton Speed Disk:

1 Click Start, point to Programs, and then click Norton Speed Disk.

The Norton Speed Disk window appears with the Optimization Map 
open. (The map colors are gray until Norton Speed Disk scans a drive.)

2 In the view bar (on the left), click an icon:

View Description

Optimization Map The Optimization Map lets you optimize drives. After 
you start optimizing, the drive map shows the file types 
in the colors displayed in the Legend. For more 
information, see “About the optimization map” on 
page 14.

Analysis The Analysis view lets you generate statistics about a 
selected drive. For more information, see “Analyzing 
drives” on page 33.

Drive Options The Drive Options view lets you customize file 
placement on a drive. For more information, see 
“Customizing file placement” on page 52.

Select a view

Select a drive

Start 
optimizing

Change legend 
colors

Menus change 
with views
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To quit Norton Speed Disk:

� From the File menu, choose Exit, or

� Click the close button on the main window.

Note: If you start optimizing a drive and then quit Norton Speed Disk, 
optimization continues running in the background until it is 
completed.

About the optimization map

The optimization map is a graphical representation of the files arranged on 
a drive. The color-coding helps you identify how efficiently drive space is 
being used. You can customize the colors used for the drive map by 
clicking the color blocks on the drive map legend. 

Schedule Options The Schedule Options view lets you set an optimization 
schedule for each drive. For more information, see 
“Scheduling optimizations” on page 41.

Legend The legend lists the file types represented by the colors 
in the drive map. For more information on file types, 
see “About the optimization map” below. To change 
the colors in the legend, see “Customizing map and 
chart colors” on page 54.

View Description

Clicking a 
color opens 
the Color 
dialog box
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Each block on the map represents a number of clusters on the drive.

For more information on what the Optimization Map colors represent, see 
“File placement during optimization” on page 23. To customize the legend 
colors, see “Customizing map and chart colors” on page 54.

Updating Norton Speed Disk
Use LiveUpdate to ensure that you have the most current program files. 
LiveUpdate is the easiest way to keep Norton Speed Disk program files 
current because it checks for—and installs—the updates automatically.

You can run LiveUpdate at any time, as long as you have an Internet 
connection.
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To run LiveUpdate:

1 From the File menu, choose LiveUpdate Norton Speed Disk.

2 Click Next and follow the prompts to proceed with the update. 

LiveUpdate goes to the Symantec FTP site to download the latest 
program file. 

The update is installed automatically.

Note: (Enterprise edition only.) If you use Norton Speed Disk for 
Windows NT/2000 Server to administer Norton Speed Disk, you can 
set up LiveUpdate to download updates from an internal network 
server. See the Norton Speed Disk Implementation Guide, which is 
included with Norton Speed Disk for Windows NT/2000 Server.

Uninstalling Norton Speed Disk 
Norton Speed Disk includes an Uninstall option in case you need to 
remove it from your computer. You can also use the system Add/Remove 
Programs utility.

To uninstall Norton Speed Disk from the Start menu:

� Click Start, point to Programs, click Norton Speed Disk, and then click 
Uninstall Norton Speed Disk.
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To remove Norton Speed Disk using Add/Remove Programs:

1 Click Start, point to Settings, and then click Control Panel.

2 Open Add/Remove Programs and make sure the Install/Uninstall tab is 
in front.

3 In the list of programs:

a Select Norton Speed Disk and click Add/Remove.

b Confirm the deletion.

4 If you need to delete any files manually, look in the following default 
installation path (or in another path to which Norton Speed Disk was 
installed):

c:\Program Files\Norton Speed Disk\*.*
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C H A P T E R 2Optimizing drives

How Norton Speed Disk works
Norton Speed Disk improves a computer’s performance by using patented 
optimization technology to increase file access speed and minimize 
refragmentation. While utilities that defragment files are providing only a 
small benefit to a user’s machine, Norton Speed Disk optimization ensures 
that servers and workstations are always running at peak performance.

How fragmentation occurs
The space on a drive is divided up into discrete units for allocating file 
space. The Windows NT file system (NTFS) uses clusters as its smallest 
allocation unit. When files are stored to the drive, they are broken up into 
cluster-size pieces that are tracked in a disk catalog. Cluster sizes vary 
depending on the overall size of the drive.

During normal file operations, file and free space fragments are created on 
the drive. As they are created, modified, and deleted, files can become 
larger and outgrow the original number of contiguous clusters allocated for 
them on a hard drive, or become smaller and no longer need all their 
allocated space. For growing files, the Windows NT file system must find 

Cluster allocation size Disk size

512 bytes <512 MB

1024 bytes 512 MB to 1 GB

2048 bytes 1 GB to 2 GB

4096 bytes >2 GB
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somewhere else to save the overflow. For shrinking files, empty space may 
be left behind where the file fragments once were.

Over time, fragments of a file may be scattered in several places, in a 
totally different area of the drive, away from the original location of the 
file. These multiple file fragments are tracked in the disk catalog, or Master 
File Table (MFT), which also grows with the addition of location 
information. 

How fragmentation affects overall performance

When files are saved or copied to a disk, there is no discrimination 
between types of files. On an unoptimized drive, all file types, including 
applications, .dlls, and data files, are intermingled. 

When a fragmented file is accessed, drive performance is slower because 
the drive head must do more work to locate, load, save, and generally 
keep track of all the fragments of the file.

High fragmentation levels affect a drive’s overall performance, because 
more demands are placed on the drive read/write mechanism. If free space 
is also fragmented, the disk head may have to hunt for adequate free space 
to store temporary files or newly added files.

Poor performance in retrieving data from the disk can affect the overall 
productivity of server applications, reflected in reduced transaction rates to 
databases, and increased levels of user frustration on mail and news 
servers.

Fragmentation also affects video and other multimedia performance. For 
example, if a multimedia file such as a movie is being played, and the 
movie file is fragmented, the player may have to wait for the disk head to 
scramble around for the next fragment to load.

Norton Speed Disk optimizes fragmented files by rearranging file fragments 
into adjacent or contiguous clusters. When the disk head can access all the 
file data in one location, the file is read into memory faster.

Before 
optimization

After 
optimization

File 1

File 2

Free Space

File 1

File 1

File 2

File 1

File 2 Free Space File 2 File 1

Free Space

Free Space

Free SpaceFile 2

File 2

File 1
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Norton Speed Disk also optimizes free space, creating contiguous free 
space on the drive. This improves system performance when you are 
adding new files, especially under low disk space conditions where free 
space fragmentation can cause newly added large files to be fragmented 
from the start.

About MFT and paging file fragmentation

Just like user data files, the MFT and paging files can become fragmented 
over time. Since these system files are accessed frequently, their 
fragmentation can cause delays in system boot time and other types of 
performance degradation.

As with any operating system’s file system, NTFS experiences file and free 
space fragmentation. This affects the read/write performance of the system 
in general, down to the core file system level. If you monitor the status of 
your MFT file you will notice that, as more read/writes are performed on 
the system and the amount of file tracking overhead data increases, the 
MFT file grows to handle the increased activity. 

Although the MFT file expands to accommodate new information, it never 
shrinks, even when the number of files decreases or disk activity slows 
down. Unlike the paging file, whose size is adjusted with each reboot, not 
even rebooting your system resets the MFT file to a smaller size. Because 
the MFT resides at the beginning of any drive partition, it has no free disk 
space to expand contiguously. NTFS is forced to find free space elsewhere 
on the same partition for the MFT file’s overflow fragments. 

Norton Speed Disk safely optimizes the MFT and paging file structures 
without the need to restart the machine, make multiple optimization 
passes, or disconnect from the network.

About directory and meta data fragmentation

NTFS stores data it uses for disk, directory, and file management in files 
called meta data. These files are also subject to fragmentation. Norton 
Speed Disk optimizes directories and meta data dynamically, without the 
need to restart the machine or make multiple optimization passes, or 
disconnect from the network.
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About free space fragmentation

Just as files can become fragmented, so can the free space on a drive. The 
lack of contiguous free space causes files to be created or extended in 
fragments. Fragmentation of the drive’s free space also has a negative 
impact on system performance, because the system has to hunt for 
multiple free spaces to store data.

In addition to defragmenting your existing files, Norton Speed Disk 
consolidates free space, so those newly created and extended files will 
remain as unfragmented as possible.

Many of the free space fragments can be too small to be usable under 
Windows NT/2000. These fragments represent drive space that is 
essentially wasted. Norton Speed Disk consolidates these free space 
fragments into large areas of free space. Free space consolidation ensures 
that new files can make use of all available disk space and are less likely to 
be fragmented the first time they are saved. 

Optimization solutions
Norton Speed Disk automatically fixes the fragmentation and organization 
problems described in the previous section. It automatically places files in 
the best location for most efficient access, flexible growth, and peak drive 
performance. It also lets you specify when to optimize and how the 
optimization should be performed. You can:

� Schedule optimizations for individual volumes based on time or 
threshold of fragmentation.

� Adjust the system resources used by Norton Speed Disk in relation to 
other running processes.

� Customize the optimization for each drive.

� Run Norton Speed Disk in the background to optimize volumes at 
preset times.

� Record optimization events to the system Event Log.

Customizable drive optimization

During optimization, Norton Speed Disk places files in the best location for 
most efficient access and flexible growth. However, there may be situations 
where you need to ensure that certain files are placed in specific areas on 
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the drive, so they are accessed first on the drive, or have lots of room to 
expand without being fragmented.

In the Drive Options view you can specify areas where individual files or 
groups of files are placed on the drive. You can also specify any files that 
you don’t want Norton Speed Disk to move. For more information, see 
“Setting drive options” on page 52.

Norton Speed Disk remembers the optimization options you choose for 
each drive, so you need not reset options each time you optimize unless 
you want to change them.

File placement during optimization

Norton Speed Disk places files in order, from the beginning of the drive to 
the end of the drive. After each main data structure Norton Speed Disk 
adds a small amount of extra space to allow for future growth with 
reduced refragmentation. The following table describes where files are 
placed during optimization.

Order 
on drive

Name Drive map legend 
label

Start Master File Table (MFT) Directory

2 Files in the Files First list in Drive Options Files Placed First 
(optional)

3 Paging File Pagefile

4 Directories Directory

5 Files accessed in the last 2 months Frequently Accessed

6 Files optimized by Norton Speed Disk Optimized

7 Files modified within the last 2 to 4 
months

Infrequently Modified

8 Files modified within the last 2 months Frequently Modified

9 Files not accessed in the last 2 months Files Placed Last

10 Files not modified in the last 4 months Infrequently Accessed

11 Files Last list in Drive Options Files Last (optional)

12 Optimized free space Free Space
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In general, the default settings will provide the best performance. You 
should change the default settings only if your files require special 
consideration. 

For example, if your company uses a utility program that updates the file 
dates even when the files are not frequently used, you may want to limit 
optimization on these files so Norton Speed Disk doesn’t move them to the 
frequently used area of the disk.

Note: The Files First, Files Last, Files At End, and Unmovable Files are 
user-defined Drive Options. For more information, see “Specifying file 
placement during optimization” on page 53.

Deciding on an optimization strategy
You may want to develop a strategy for optimizing your drives. Although 
the impact of Norton Speed Disk optimization should not be noticeable, 
there may be times when you want no impact at all. For example, if you 
manage network drives you may want to schedule optimization to run at a 
time when the fewest number of users will be using a busy server. This will 
also decrease the amount of time it takes for Norton Speed Disk to 
complete optimization.

Which optimization strategy you adopt depends on your needs and your 
drive characteristics. For example, the strategy adopted for servers, which 
may have a lot of transitory traffic, security issues, and variable workloads, 
will be different than the strategy used for workstations, which may have 
groups of files that are used in routine patterns.

For example, if your company has seasonal demands, such as monthly or 
quarterly budget forecasts where many departments are sending data in 
separate files for consolidation, you will want to optimize before and after 

-- Extra space placed after data files to allow 
for growth

Slack Space

-- Files and other disk data not yet optimized Fragmented

13 Files in the Files At End list in Drive 
Options

Files Placed At End 
(optional)

Order 
on drive

Name Drive map legend 
label
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the budgeting process. In preparation for the main budgeting month, you 
optimize the drive to make sure adequate disk space is available for 
hundreds of small contributory data files as well as for the growing size of 
the main budget file. After the budgeting process is over for another year, 
budget files have stabilized and contributory data has been archived, you 
optimize the drive again to consolidate the empty space left by deleted 
files.

In a Web or desktop publishing group, your drives might hold source files 
for multiple projects, including text and graphics files, that are worked on 
for a few weeks or months, are completed, and replaced by others. With 
hundreds of small files being created, copied, modified, and deleted, your 
drives may need optimization based on fragmentation threshold, or on 
demand, after a project ends.

In general, the drive size, the percentage of files to free space, and the 
percentage of fragmented files (to total files) affect the decision about 
when and how frequently to optimize a drive.

� Expect optimization to take longer the first time it is run on a volume. 
This is because Norton Speed Disk must relocate all the data on the 
drive into the optimum order described in “File placement during 
optimization” on page 23.

If you schedule regular optimization to maintain this file placement, 
subsequent runs on the same drive will quickly clean up fragmentation 
that has occurred since the last optimization, while leaving the majority 
of previously optimized files where they are.

� Large drives that are nearly full may take longer to optimize, especially 
if they are heavily fragmented. Cleaning out \temp directories, the 
Internet cache, and the Recycle Bin, and removing software that is no 
longer used creates free space that will significantly speed up the 
optimization process.

� Norton Speed Disk can safely optimize drives on systems that are in 
active use. The resulting optimization may not be 100% perfect, as files 
may be created, extended, truncated, or deleted during the run, but 
most of the benefits of optimization will still be realized.

� Schedule Norton Speed Disk to run during off-peak hours. If the 
system runs full time and really has no off-peak hours, you can run 
Norton Speed Disk with its normal resource setting, which runs at a 
lower priority than other processes. This approach may take longer, 
and may be subject to more user activity (file creation, extensions, 
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truncations, and deletions) but will still result in significant 
performance improvements.

Optimization issue Suggestions

Number of files The more files on the drive, the more time is 
needed for optimization. 

You will need to consider the drive’s total number 
of files and the file types, for example, large 
contiguous databases vs. numerous small document 
files. To help determine the status of the drive, run 
the Analyze Drives feature described on page 33.

Number of file 
fragments

The more file fragments, the more time is needed 
for optimization. 

Number of 
fragmented files

The greater the number of fragmented files, the 
more time is needed for optimization.

Free disk space The more free disk space there is on the drive, the 
faster optimization will occur.

Priority (given to 
optimization in 
relation to other drive 
activity)

The greater the priority given to Norton Speed 
Disk, the faster optimization will complete. You can 
adjust this setting in the Priority settings described 
on page 46.

Available memory and 
other workload 
demands

The real-time workload (how frequently the drive is 
accessed and for what types of activities), as well as 
available memory, affect optimization time. The 
more workload, the longer optimization may take.

If you are optimizing during working hours, 
optimization may take longer because memory is 
being shared with other applications. Optimization 
during off-peak hours, when traffic is minimal, will 
reduce optimization time.

Drive size The number of files and file fragments affect the 
amount of time needed for optimization. 
Optimizing a highly fragmented smaller drive may 
take longer than optimizing a lightly fragmented 
larger drive.

Number of processes 
running on the system

The more processes running, the more time is 
needed for optimization. 

Processor speed The slower the processor speed, the more time is 
needed for optimization.
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Initial optimization time

A drive’s first optimization may take significantly longer than the 
subsequent optimization. Norton Speed Disk must move the files and free 
space into the order described in “File placement during optimization” on 
page 23. After a drive has been optimized, only new and expanded files 
will need optimization.

The benefits of optimization, which include faster access and improved 
overall performance, make the time worthwhile almost immediately. 
Norton Speed Disk takes advantage of the solid foundation established in 
the first optimization to dramatically reduce run time in subsequent 
optimizations.

Tip: If you find that optimization is taking too much time, or using too 
many system resources, you may want to fine tune the Norton Speed Disk 
global options. For more information, see “Setting global options” on 
page 45.

Preparing for optimization
Before optimizing any drives, you should make the following preparations:

Before optimizing, do this Why you should do it

Run the CHKDSK utility to 
identify and repair any disk 
errors before running Norton 
Speed Disk.

Although you can set an option to have Norton 
Speed Disk automatically scan for errors on 
NTFS volumes before optimizing, it’s best to run 
CHKDSK in advance of Norton Speed Disk to 
identify and repair any bad sectors or other file 
or disk damage that could cause problems 
during optimization. Running CHKDSK also 
ensures that lost file sectors or chains are not 
included in the optimization.

Delete temporary and 
obsolete files such as those in 
the \Temp directory, any 
spool folders, any Internet 
temporary files, the Recycle 
Bin, and so on.

This avoids the extra work of optimizing 
obsolete, unused, and trash files that consume 
optimization time and resources. Including these 
file in optimization means that useful space is 
occupied by useless files, causing the drive to 
become refragmented when these files are 
emptied from the Recycle Bin or erased from 
temporary folders.
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Running the initial optimization

Once you have ensured that the drive is ready for optimization by 
following the suggestions listed in the previous section, “Preparing for 
optimization” on page 27 you are ready to begin optimizing. 

To optimize a drive:

1 In the Select A View list, select Optimization Map.

2 Select the drive to optimize.

3 Click Start Optimizing.

Norton Speed Disk proceeds to optimize the drive. 

You can watch Norton Speed Disk progress in the Optimization Map 
or minimize the window and continue with other work.

Complete any major software 
installations or uninstallations 
before optimizing. 

This reduces the necessity to reoptimize after the 
installation or uninstallation. Typically, 
installation processes create temporary files, and 
occupy large amounts of space temporarily. 
Uninstalling programs after optimizing creates 
unnecessary work.

Back up your files. It’s always a good idea to back up your software. 
Although Norton Speed Disk maintains the 
integrity of your data, we strongly recommend 
that you back up important files before making 
any major changes to your drives, including 
optimization. Maintaining a schedule of regular 
backups is good practice at any time.

Before optimizing, do this Why you should do it
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After it has scanned the drive, the optimization map displays the file 
distribution and fragmentation.
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As optimization progresses, the map changes to reflect the 
reorganization of files on the drive.



Preparing for optimization

31

Phases of optimization

Norton Speed Disk goes through several phases in the course of 
optimization. 

Phase Activity

Verifying drive integrity on 
NTFS volumes (optional)

When this setting in the Global Options is 
turned on (the default setting is off), Norton 
Speed Disk runs a brief check of the NTFS drive 
for any problems. To change this setting, choose 
Global Options from the View menu and click 
the Scan for errors before optimizing NTFS 
volumes check box. For more information, see 
“Adjusting priority and memory resource use” on 
page 46.

If problems are found, you are prompted to run 
the Windows NT CHKDSK command to reclaim 
lost chains and repair any disk damage.

Scanning Norton Speed Disk scans the entire hard drive 
and gathers information about how many files of 
each file type are present, the amount of empty 
space, and the number of partially used clusters.

Gathering data on file fragmentation and 
unmovable files can take some time, depending 
on the size of the volume, the number of files on 
the volume, and the degree of file 
fragmentation.

Unmovable files are distinguished in the 
optimization map after the drive is scanned in 
the first phase of optimization. However, to save 
time, the map does not distinguish fragmented 
or unmovable files until after Norton Speed Disk 
performs a fragmentation analysis.

Sorting Norton Speed Disk sorts the files according to 
the types described in “File placement during 
optimization” on page 23.

Moving Norton Speed Disk moves the files into the areas 
of the drive assigned to their types, as described 
in “File placement during optimization” on 
page 23.
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Note: On non-NTFS volumes you will be prompted to run CHKDSK before 
optimizing.

About unmovable files

Windows NT/2000 produces some files and file fragments during system 
operation that are classed as unmovable. NTFS system files, (except for the 
MFT, root directory, and paging file) can’t be moved. Directories and 
paging files on FAT volumes also cannot be moved.

Fragments on the drive identified by Norton Speed Disk as unmovable are 
not moved during optimization. You can also designate any file or group of 
files to be unmovable by selecting the Drive Options for a drive, opening 
the Unmovable tab, and adding the file or group of files to the Unmovable 
tab.

Tip: For Norton Speed Disk, very few file types are unmovable. If you 
notice that some files are not optimized, check the access rights to the files. 
You must have administrator rights to the drive for Norton Speed Disk to 
move some types of files that are defined by the administrator, or are 
defined by administrator for another user. 

About extra space

On the drive map you may see small blocks of extra space mixed in with 
optimized files, even after Norton Speed Disk has optimized a drive. This is 
another way Norton Speed Disk maintains a drive’s optimization longer. 
Norton Speed Disk adds extra space after each category of optimized files 
to allow for future growth. This allows categories of files to expand 
without causing immediate fragmentation.

Optimizing multiple drives concurrently
You can start several optimizations concurrently by selecting drives and 
starting optimization on one drive after another.

To optimize multiple drives:

1 In the Select A View list, select Optimization Map.

2 Select the first drive you want to optimize.
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� To see a pre-optimization fragmentation analysis, click the Analyze 
view icon first. For more information, see “Analyzing drives” on 
page 33.

3 Click Start Optimizing.

Norton Speed Disk proceeds to optimize the drive.

4 Select another drive in the list and click Start Optimizing. The 
maximum number of concurrent drive optimizations is unlimited, but 
the recommended number is 2 or less. 

Note: Each concurrent optimization requires additional system 
resources. For example, to optimize three drives concurrently, Norton 
Speed Disk needs three times as many system resources as for a single 
optimization. If you plan to start or schedule concurrent optimizations, 
make sure you plan sufficient system resources to complete 
optimization in the time you expect. For more information, see 
“Adjusting priority and memory resource use” on page 46.

Analyzing drives
Norton Speed Disk performs an analysis of each drive to help you 
determine the state of the drive prior to optimization. The Analysis view 
displays file fragmentation, free space fragmentation, and general drive 
utilization. The lower part of the view lists the most fragmented files with 
the number of fragments.

To generate a fragmentation analysis:

1 Click the Analysis view icon.

2 Select the drive you want to analyze.
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3 Click Start Analyzing.

The time needed for fragmentation analysis depends on the degree of 
fragmentation, size of the drive, and number of files on the drive. 

4 To stop the analysis at any time, click Stop Analyzing.

Note: You can change the colors displayed in the pie chart legend. For 
more information, see “Customizing map and chart colors” on page 54.

Analyzing multiple drives

You can analyze multiple drives concurrently by selecting drives and 
starting their analysis one after the other.

To analyze multiple drives concurrently:

1 In the Select A View list, click the Analysis view icon.

2 Select the first drive you want to analyze.

3 Click Start Analyzing.

Norton Speed Disk proceeds to analyze the drive.

4 Select another drive in the list and click Start Analyzing.

Norton Speed Disk proceeds to analyze the second drive.

5 Continue selecting drives until you have selected all the drives you 
want Norton Speed Disk to analyze concurrently.
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Types of analysis

The drive analysis statistics are grouped into four types: optimization level, 
free space fragmentation, drive utilization, and most fragmented files. 
These are all described below.

Optimization Level analysis

The optimization analysis checks for the number and percent of 
fragmented files.

If you have a high number of fragmented files, or a large percent of 
fragmented files on the drive, you should run Norton Speed Disk.

Free Space Fragmentation analysis

The free space fragmentation analysis displays information about the 
drive’s free space.

Some applications and processes require a certain amount of free space to 
perform effectively. Lack of contiguous free space can impede 
performance for these applications. For example, Microsoft Word creates at 
least one, and often several, temporary files when a document is open. 
Database files may need at least twice the data file’s size to write temporary 
files to the drive during sorting, updating, or other activity. Print spooling 

Statistic Description

Total Files The total number of files on the drive.

Fragmented Files Number of fragmented files.

Percent Fragmentation The percentage of fragmented files on 
the drive.

Statistic Description

Free Spaces The total number of free space 
fragments on the drive.

Free Clusters The total number of free clusters on the 
drive.

Largest Free Space The size, in clusters, of the largest free 
space on the drive.
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also requires large amount of disk space when the entire document is 
printed to the drive before being sent to the printer.

Note: If a drive’s largest free space is small (10% or less of the overall drive 
size), initial optimization may take longer. Norton Speed Disk needs free 
space to store temporary files during optimization. If drive space is limited, 
Norton Speed Disk must process a higher number of smaller temporary 
files. The combination of increased processing time and smaller temporary 
file sizes results in the longer optimization.

Disk Utilization analysis

The Disk Utilization analysis summarizes how space is used on the drive.

Most Fragmented Files analysis

This analysis lists the files with the most fragments. 

If you notice that these files become fragmented frequently, even after 
optimization, you may wish to specify where you want these files placed 
during optimization. 

Statistic Description

Bytes Used The total number of bytes occupied by files or 
file fragments on the drive.

Bytes Free The total bytes of free space on the drive.

Percent Of Disk Used The percentage of occupied drive space.

Number Of Folders The total number of folders on the drive.

Number Of Files The total number of files on the drive.

Statistic Description

File Name The path and filename of the file.

Fragments The number of fragments belonging to the 
file.
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For example, perhaps a file is growing very large and needs more space 
than is available on the drive. You could use the Drive Options to specify 
the file be placed in the Files Last category, closest to the free space, so the 
file can grow larger and remain unfragmented.

Working with the most fragmented files

You can use the Analysis view to identify the most fragmented files, and 
then use that information to reduce their susceptibility to repeated 
fragmentation. After you run the analysis, any highly fragmented files are 
listed in the Most Fragmented Files list.

Most 
fragmented 
files
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The list shows the file name, location, and number of fragments.

If these files become fragmented frequently, even following optimization, 
you can use the Drive Options to specify where you want Norton Speed 
Disk to place that file during the next optimization. For more information, 
see “Setting drive options” on page 52.

For example, lets say you have a large database to which several people 
have been adding and updating records. The file has become fragmented, 
and you know it is likely to be increasing in size. In the Drive Options, you 
can add the database filename to the Files Last list. The next time Norton 
Speed Disk optimizes this drive, this file will be rejoined and moved close 
to free space, where its expansion will not cause it to fragment.

Adding temporary files to the Files Last drive option

If you use any software that consistently creates temporary files, add them 
to the Files Last category so that Norton Speed Disk places them at the end 
of all the other files, and adjacent to the optimized free space so they have 
room to expand. For example, you could add temporary Internet files in 
Internet Explorer, temporary cache files in Netscape Navigator, files in the 
Recycle Bin, and files in the Windows Temp directory.

The following paths show typical locations for temporary files, if a user’s 
TEMP and/or TMP environment variables point to c:\TEMP, and C: is the 
volume to be optimized:

\TEMP\**\*

\Recycled\**\* (FAT volumes)

\Recycler\**\* (NTFS volumes)
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Internet Explorer URL history:

\WINNT\History\**\*

Internet Explorer cache:

\WINNT\Profiles\user1\Temporary Internet Files\**\*

Netscape Navigator cache:

\Program Files\Netscape\Communicator\cache\**\*

Netscape Navigator main directory (JAVA, plugins, etc.):

\Program Files\Netscape\Communicator\**\*

Note: The double asterisk characters [**] indicate that all files below the 
path are included in the selection.
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C H A P T E R 3Customizing Norton 
Speed Disk

About Norton Speed Disk options
You can customize Norton Speed Disk optimization. For example, you can 
have Norton Speed Disk:

� Automatically optimize volumes based on threshold of fragmentation, 
and record optimization events to the system Event Log. See “Setting 
global options” on page 45.

� Customize the optimization for each disk volume and for each 
scheduled task, including how Norton Speed Disk places files on each 
drive. See “Setting drive options” on page 52.

� Optimize automatically from a schedule created in Norton Speed Disk. 
See “Scheduling optimizations” below.

� Run in the background to optimize volumes at preset times. See 
“Scheduling optimizations” below.

Scheduling optimizations
Norton Speed Disk lets you schedule optimization tasks to run 
automatically at preset times when drive activity is light. Scheduled 
optimizations are all run silently in the background, with no interruption or 
notification to users.

You can specify optimization schedules for each drive. As part of the 
schedule you can tell Norton Speed Disk to optimize based on the percent 
of fragmentation, and you can also set a specific schedule.
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How often to use Norton Speed Disk

Any time a drive’s response time becomes slower, or when a drive analysis 
indicates that a large percentage of files are fragmented, you should use 
Norton Speed Disk to restore the drive’s performance. 

Note: Optimizing multiple drives concurrently will affect overall 
performance. The maximum number of concurrent drive optimizations is 
unlimited, but the recommended number is 2 or less. 

Setting a scheduled optimization time

You can schedule regular optimization on a recurring day and time, or by 
the percent of fragmentation level. 

To have Norton Speed Disk optimize at a set time:

1 In the Select A View list, select Schedule Options.

2 Select the drive whose schedule you want to set.

3 Click the Enable Schedule check box.

Note: On non-NTFS volumes, checking this option will prompt you to 
run CHKDSK/F manually after you click Apply.
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Select a frequency from the list. Your options are:

4 Select a start time for optimization.

If you want to ensure that optimization will not continue after a certain 
time, for example, when another process is due to start, or at a time 
when network traffic is heavy, you can also set a stop time. Otherwise, 
Norton Speed Disk runs until optimization is complete.

5 Click Apply.

Note: Scheduled optimizations take place in the background. When it 
is running in the background, Norton Speed Disk gives priority to all 
other NT processes. If many other processes are constantly using 
system resources, scheduled optimizations may not have enough 
resources to complete as quickly as you expect. To give scheduled 
optimizations greater priority over other running processes, you can 
alter the Priority setting in the Global Options dialog box. For more 
information, see “Adjusting priority and memory resource use” on 
page 46.

Setting a fragmentation threshold

In the Schedule Options you can select a fragmentation threshold. When 
the selected drive reaches the specified degree of fragmentation, Norton 
Speed Disk will optimize it. 

You can select Auto Threshold or enter a percentage. The default 
fragmentation percentage threshold is determined by the drive’s 
fragmentation level, and is managed by the Auto Threshold feature.

For example, if you set the fragmentation threshold to 5% (within the 
recommended range) Norton Speed Disk will begin optimizing in the 
background when the level reaches that percent. 

Startup Optimization occurs every time the machine is 
started.

Once Optimization occurs once at the time and date you 
specify.

Daily Optimization occurs daily at the time you specify.

Weekly Optimization occurs weekly at the time and day you 
specify.

Monthly Optimization occurs monthly at the time and day 
you specify.
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To set an optimization schedule by threshold:

1 In the View list, select Schedule Options.

2 Select the Optimize Based On Threshold check box. 

Auto Threshold is enabled by default. It will cause Norton Speed Disk 
to optimize the selected disk when fragmentation goes over an amount 
determined by the drive characteristics.

3 To specify another threshold, select Only Optimize Drive If 
Fragmentation Exceeds: and enter a percentage value. The 
recommended percentage is between 2% and 5%. 

This ensures that Norton Speed Disk optimizes when the fragmentation 
percentage reaches the level you specify, at the scheduled time.

4 Click Apply.

Note: The threshold setting only applies to drive optimizations that 
you schedule. The schedule must be enabled for this setting to take 
effect.

Optimizing in the background

There are several ways to run Norton Speed Disk in the background:

� Use the scheduling feature of Norton Speed Disk to specify when and 
how you want the drive volumes optimized. All scheduled 
optimizations run in the background. For more information, see 
“Scheduling optimizations” on page 41.

Note: If you are scheduling optimizations on several drives, use the 
Maximum Concurrent Drive Optimizations setting (page 48) to specify 
the maximum number of drives that Norton Speed Disk optimizes at 
any one time.

� Close or minimize Norton Speed Disk after starting the optimization. 
For more information, see “Start optimization and close” on page 45.

� Minimize the effect of background optimization on applications 
running in the foreground by setting the optimization priority to Idle. 
To set the optimization priority, choose View > Global Options and 
drag the Priority slider to Idle. For more information, see “Adjusting 
priority and memory resource use” on page 46.
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Start optimization and close

When you start Norton Speed Disk and close the program, optimization 
continues unless you want it stopped.

To start and close:

1 Start Norton Speed Disk.

2 In the Select A View list, click Optimization Map.

3 Select a drive and click Start Optimizing.

Once optimization has started, you can quit Norton Speed Disk, and 
optimization continues in the background.

4 From the File menu choose Exit.

Norton Speed Disk asks if you want to stop optimization.

5 To keep optimizing in the background, click Continue.

If you don’t want to be prompted again, select the Never Ask Me This 
Again check box.

Setting global options
Norton Speed Disk global options affect its overall performance during 
optimization:

� On the Settings tab (page 46), you can customize how Norton Speed 
Disk uses your system’s resources. 

� On the Event Logging tab (page 48), you can specify what events to 
log and if and when to send alerts. 

� (Enterprise edition only.) On the Install tab (page 51), network 
administrators using Norton System Center can configure Norton Speed 
Disk installation. (This tab only applies when Norton Speed Disk is 
used in combination with Norton System Center. For more information, 
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see the Norton Speed Disk for Windows NT/2000 Implementation Guide 
on the Norton Speed Disk for Windows NT Servers CD.)

To set Norton Speed Disk global options:

1 From the View menu, choose Global Options.

2 In the Options dialog box, click the Settings or Event Logging tab.

3 Make changes to the options and click Apply.

4 When you are finished making changes in the Options dialog box, 
click OK.

Adjusting priority and memory resource use

The Settings tab lets you adjust Norton Speed Disk use of machine 
resources. When you adjust the Priority and Memory Usage settings, you 
determine how much of the machine’s resources Norton Speed Disk uses 
to optimize. 

Normally, Norton Speed Disk takes low priority. If you want to optimize 
faster at the possible expense of other processes that may be running 
concurrently, you can move the slider to a higher priority. If you do not 
want Norton Speed Disk to optimize before other processes run, you can 
minimize the effect of background optimization by adjusting the Priority 
setting.

To adjust optimization priority:

1 From the View menu, choose Global Options.
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2 On the Options dialog box Settings tab, move the Priorities slider to 
Low or High.

Setting Description Effect

Priority Sets Norton Speed 
Disk priority for 
using system 
resources. 

Low - Machine must 
be idle before Speed 
Disk processes take 
priority.

Medium - For this 
default setting, other 
processes on the 
machine take 
priority over Speed 
Disk processes. 

High - Speed Disk 
processes share 
normal priority with 
other processes.

Priority = Low:
Optimization takes longer but 
uses fewer machine resources.

Priority = Medium:
Optimization takes some time, 
letting other machine resources 
take priority.

Priority = High: 
Optimization is faster but uses 
more machine resources and 
has more impact on other 
running software.

Memory Usage Sets Norton Speed 
Disk priority for 
using memory. 

Low - Norton Speed 
Disk memory usage 
is aggressively 
trimmed.

Medium - This 
default setting is 
recommended in 
most cases.

High - The bitmap is 
compressed. (This 
setting is not 
recommended 
unless no other 
applications are 
running during 
optimization.)

When the slider is moved to the 
left, optimization takes longer 
but uses less memory. When the 
slider is moved to the right, 
optimization is faster, but uses 
more memory.
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Note: On non-NTFS volumes, checking this option will prompt you to 
run CHKDSK/F manually after you click Apply.

Recording optimization events

You can record optimization events to the Event Log maintained by the 
system and view the records using the system Event Viewer. These events 
can also be sent to the Norton System Center Console. The Event Logging 
tab lets you specify which event types to log (Error, Warning, or 
Information), and what notification, if any, to send to administrators or to 
the Norton System Center Console. 

Note: For a list of events, see “Event types” on page 57.

Configuring event types

Use the Event Logging tab to define what types of events are logged for 
Norton Speed Disk activity.

Maximum 
Concurrent Drive 
Optimizations

Limits the number of 
drives that Norton 
Speed Disk is 
allowed to optimize 
at the same time. 

The default setting 
is 2. If you start a 
third optimization, 
one of the first two 
optimizations must 
finish before the 
third can begin.

The higher the number of drives 
being optimized concurrently, 
the more machine resources will 
be used by Norton Speed Disk, 
and the longer each 
optimization will take. 

The maximum number of drives 
Norton Speed Disk can optimize 
concurrently is unlimited, but 
the default setting of 2 (or less) 
is recommended.

Scan For Errors 
Before Optimizing 
NTFS Volumes

Norton Speed Disk 
quickly checks the 
NTFS volume for 
any errors before 
optimizing.

The default is off.

If the integrity check runs while 
there is disk activity, it may 
report false errors. Other 
processes should not be running 
if you use this option.

Setting Description Effect
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To configure event types:

1 From the View menu, choose Options.

2 On the Event Logging tab, select an event.

3 Click Modify.

4 In the selected event’s dialog box, enable the event.

5 Specify an Event Type for the selected event:

� Information

The event is for information only and no further action is needed.

� Warning

The event may indicate a problem and should be investigated 
further.

� Error

The event indicates an error, for example, that Norton Speed Disk 
was not able to complete optimization.

Full description 
of event

Click to enable 
this event Specify what 

action to take

Configure the 
type of event

Enterprise edition 
only
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6 Specify how you want the event handled:

� Log Event To Local Machine

The event is added to the workstation’s event log and can be 
viewed by the System Event Viewer.

� (Enterprise edition only) Alert Administrators

The event is added to the workstation’s event log and an alert is 
sent to administrators listed in the system information.

� (Enterprise edition only) Send Event To NSC Console

The event is added to the workstation’s event log and an alert is 
sent to the NSC Console.

7 Click OK.

8 Continue selecting and configuring events in the list.

9 On the Event Logging tab, click Apply, or click OK to apply changes 
and close the dialog box.

10 To disable all event logging, select Disable All Events.

Sending events

You can also have Norton Speed Disk send administrative alerts to the 
system administrator or to another user whenever a Norton Speed Disk 
event occurs. The event need not be logged in order to send alerts. You 
can configure alerts from the Server control in the Windows Control Panel. 

Note: To use the alert feature, the Alerter and Messenger services must be 
running.



Setting global options

51

To send alerts:

1 On the Event Logging tab, make sure event logging is enabled.

2 Choose a Norton Speed Disk event.

3 Click Modify.

4 If the event is to be logged, choose how the event should be labeled in 
the log (Information, Warning, or Error).

5 To send an administrative alert when this event occurs, check Send 
Administrative Alert. (The event need not be logged to send 
administrative alerts.)

You can view recorded optimization events in the System Event Viewer. To 
use the alert feature, the Alerter and Messenger system services must be 
running.

Note: For a list of all available events, see “Event types” on page 57.

Install tab settings

The Install tab is available for the Norton System Center snap-in version of 
Norton Speed Disk. If you are not using Norton System Center, you can 
disregard this tab.

This option lets network administrators use the Norton System Center 
Console to install the command-line version of Norton Speed Disk.

For more information, see the Norton Speed Disk Implementation Guide 
PDF file on the Norton Speed Disk for Windows NT/2000 Server CD.
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Setting drive options
These options determine how Norton Speed Disk optimizes specific drives. 
For example, if one drive contains mostly data, and another contains a 
combination of data and frequently-used applications, you may want to 
specify file placement for the frequently-used applications.

About file placement

In general, Norton Speed Disk default settings for placing files provides the 
best performance. Change the drive’s default settings only if your files 
require special consideration. 

For example, if you use a disk utility that updates certain file dates even 
when those files have not been used, you may want to limit optimization 
on these files so Norton Speed Disk doesn’t move them to the area of the 
disk reserved for frequently used files.

Customizing file placement

If you want to place files in a specific location, overriding the Norton 
Speed Disk default file placement, use the Drive Options view. This view 
lets you select files or file types and specify where they should be placed 
during optimization.

For more information about optimizing file locations, see “File placement 
during optimization” on page 23.
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To set drive options:

1 In the Select A View list, click the Drive Options icon or select Drive 
Options from the View menu.

2 Select the drive whose options you want to change.

3 Make the changes to the options tabs.

Your changes take effect immediately.

Specifying file placement during optimization

The drive options let you specify how you want files placed during 
optimization.

� Files First

Speed Disk places the selected files at the very beginning of the disk 
for fastest access. Files that are frequently accessed but not modified, 
such as program (.EXE and .DLL) files, should be placed first on the 
disk.

� Files Last

Use this option to place infrequently used files after all other files, but 
before the free space.
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� Files At End

Use this option to place selected files after all the other files and free 
space. Place infrequently accessed files here.

� Unmovable Files

Use the Unmovable Files option to specify files that you do not want 
moved during optimization. For example, if you have applications that 
expect files in specific locations on the disk, make sure they are added 
to this list.

To add files to the Files First, Files Last, Files At End, or Unmovable 
Files lists:

1 Select the drive whose file placement you want to customize.

2 Bring the Files First, Files Last, Files At End, or Unmovable Files tab to 
the front.

3 To add a single file:

a Click Add File.

b Locate and select the file you want to add.

c Click OK.

4 To add a group of files of the same file type:

a Click Add Wildcard.

b Enter the wildcard characters (such as *.EXE or *.DLL) and click OK.

Customizing map and chart colors
You can customize the colors that appear on analysis charts and drive 
optimization maps by changing the Legend colors. The changes you make 
apply to all charts and drive maps.
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To customize drive map colors:

1 In the Select A View list, click the Optimization Map or Analysis view.

2 Click any color in the Legend.

3 Click the color you want to represent this type of block in the drive 
map.

4 Click OK.

Click any 
color to open 
the Color 
dialog box
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A P P E N D I X ANorton Speed Disk events

Event types
The following events can be recorded in the Norton Speed Disk event log. 
You can change the type and status of these events, and specify if you 
want an alert sent to an administrator or to another workstation. For more 
information, see “Recording optimization events” on page 48.

Event Name Status Type

Norton Speed Disk service started Disabled Information

Norton Speed Disk service 
stopped

Disabled Information

Optimization started on a drive Disabled Information

Optimization not necessary: 
Fragmentation below threshold

Disabled Information

Optimization terminated at user 
request

Disabled Information

Optimization completed 
successfully

Disabled Information

Optimization partially complete: 
Files created/extended during the 
run were not optimized

Disabled Information

Optimization would complete 
faster if more free space was made 
available on the volume

Enabled Error
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Optimization partially complete: 
Account running Norton Speed 
Disk does not have access to one 
or more files

Enabled Error

Optimization terminated: 
Insufficient free space

Enabled Warning

Optimization terminated: Invalid 
drive

Enabled Warning

Norton Speed Disk driver 
unavailable or corrupt

Enabled Warning

Norton Speed Disk driver failed: 
Unknown service pack

Enabled Warning

Optimization terminated: 
Insufficient memory

Enabled Warning

Optimization terminated: Device 
went offline during run

Enabled Warning

Optimization terminated: Data 
corruption detected

Enabled Warning

Optimization terminated: 
Unrecognized exception

Enabled Warning

Optimization not started: Volume 
integrity check failed

Enabled Warning

Event Name Status Type



59

A P P E N D I X BFrequently asked questions

This section includes frequently asked questions and other topics related to 
Norton Speed Disk. 

Note: Be sure to check the Readme.txt file included with the installation 
files for any late-breaking issues not covered in this section. 

Compatibility - Hardware

Does Norton Speed Disk work on NTFS partitions?

Yes. Norton Speed Disk is compatible with any partition that is Windows 
NT 4.0 compatible.

Does Norton Speed Disk work on FAT16 partitions?

Yes.

Does Norton Speed Disk work on FAT32 partitions?

Yes, on Windows 2000 only. However, prior to optimizing you will be 
prompted to run CHKDSK if on these volumes.

How do I run CHKDSK manually?

Select Start/Programs/Command Prompt (NT4) or Start/Programs/
Accessories/Command Prompt (Windows 2000) and type the command

CHKDSK X: /F (Where X: is the letter of the drive to be optimized). Follow 
any on-screen prompts.
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Why doesn’t Norton Speed Disk completely optimize my FAT 
volume?

For FAT volumes, Norton Speed Disk uses the Windows MoveFile 
technology, which does not defragment directories, MFT, or paging files. 
Norton Speed Disk does optimize these types of files on NTFS drives.

Does Norton Speed Disk work with SCSI drives, mirrored drives, 
RAID systems (often seen as RAID Level 5), and striped sets with or 
without parity?

Yes.

Can Norton Speed Disk optimize removable drives such as Zip and 
Jaz drives?

Yes, as long as the media is in the drive before starting Norton Speed Disk. 
Norton Speed Disk scans for readable media before it starts up.

Will Norton Speed Disk work with cluster servers?

This version of Norton Speed Disk is not cluster-aware. There will be no 
failover capabilities. Like other software running in a MSCS environment, 
you can install Norton Speed Disk to all member servers on non-shared 
drives. Do not install Norton Speed Disk to a shared drive. Since shared 
drives are visible only to one machine, if you run Norton Speed Disk 
normally on all member servers, both shared and local drives will be 
optimized. 

Does Norton Speed Disk work on HPFS partitions?

No. HPFS partitions are not compatible with Windows NT 4.0.

Does Norton Speed Disk work on DEC Alpha systems?

No. It is compatible with x86 processors only. The minimum requirement is 
an Intel 80486/66 processor (Pentium processor recommended).

Does Norton Speed Disk work on 8K clusters?

Yes. On NTFS and FAT drives, Norton Speed Disk will work on any cluster 
size.
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Compatibility - Operating systems

Does Norton Speed Disk work in Windows 95 and Windows 98?

Norton Speed Disk will only work when the system is booted into 
Windows NT/2000. It will not work when booted into Windows 9x. 

To run Norton Speed Disk from within Windows 9x, install Norton Utilities 
for Windows 95, version 5.0, when you are booted into Windows 95 or 
Windows 98.

Does Norton Speed Disk work on Windows NT 3.51?

No. Symantec does not have a defragmenter for Windows NT 3.51.

Does Norton Speed Disk work on Windows NT 4.0 with Service Pack 
1 or Service Pack 2?

Norton Speed Disk was written to work with Windows NT 4.0, Service 
Pack 3, 4, 5, or 6. It should not be installed on a system that has Service 
Pack 1 or 2 installed.

Does Norton Speed Disk work on Windows 2000 (Windows NT 5.0)?

Yes.

Does Norton Speed Disk in Norton Utilities for Windows NT/2000 
work on Windows 95 partitions?

Norton Speed Disk is compatible with any partition that is recognized by 
Windows NT 4.0. It works on all types of Windows 95 partitions. 

Does Norton Speed Disk replace any Windows NT system files in 
order to work?

No. 

What if I have a FAT32 partition?

Norton Speed Disk is compatible with any partition that is Windows NT 4.0 
or Windows 2000 compatible. This includes NTFS, FAT16, and FAT32 
partitions. Third-party FAT32 drivers for NT 4.0 are not supported. 
However, prior to optimizing you will be prompted to run CHKDSK if on 
these volumes.
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Compatibility - Other

Does Norton Speed Disk work on memory-mapped databases (such 
as Oracle)?

Yes.

What is the difference between Norton Speed Disk disk optimization 
and file defragmentation?

Disk optimization refers to defragmenting all elements on a drive 
(including the paging file, directories, MFT, metadata, free space, and files), 
reordering the elements to improve the speed at which critical elements 
can be accessed, and allocating small amounts of slack space to prevent 
future fragmentation.

File defragmentation refers simply to reordering non-contiguous pieces of 
a file in order to make them contiguous. For more information, see 
“Optimization vs. defragmentation” on page 7.

Can you schedule Norton Speed Disk?

Yes. For details, see “Scheduling optimizations” on page 41.

Does Norton Speed Disk defragment the Master File Table (MFT)?

Yes.

Does Norton Speed Disk defragment directories?

Yes. 

Does Norton Speed Disk defragment meta data?

Yes. 

Can Norton Speed Disk optimize multiple hard drives at the same 
time?

Yes, Norton Speed Disk can optimize multiple hard drives concurrently. 
You must select and start them individually, or schedule them sequentially.
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Can you run Norton Speed Disk from a floppy?

No. Norton Speed Disk is a Windows NT/2000 application, and can only 
be run while the system is booted into Windows NT/2000.

Why is the fragmentation percentage higher after shutting down and 
rebooting?

Norton Speed Disk figures obtained before shutdown are not an exact 
indication of fragmentation after shutdown. Shutting down a system flushes 
the buffer (disk cache) to the hard drive, so after you reboot, a more 
accurate analysis of the hard drive is possible.

The figures obtained after rebooting may indicate a higher percentage of 
fragmentation if there are many files that must be moved on a first-time 
optimization. In this case, Norton Speed Disk might need more than one 
pass to fully optimize a system. However, this is the exception.

What files are unmovable?

Norton Speed Disk does not move the following file types:

� Some types of meta data files. Certain meta data such as the volume 
bitmap, boot record, and the bad-block file may be considered 
unmovable for safety reasons.

� Files for which you don’t have access rights. For example, if there are 
shared files on a volume, you must log in with Administrator rights 
before starting Norton Speed Disk or the file system will not allow the 
file to be moved.

� On FAT volumes the paging file and directories are not moved, 
because Norton Speed Disk uses a different technology on FAT 
volumes than is used on NTFS volumes. A FAT volume, however, is 
still optimized.

How can I perform Norton Speed Disk operations from the command 
line? (Enterprise edition only)

The Sdntrun.exe command is available for command-line optimization. 

� On the command line, enter Sdntrun.exe followed by the drive letters 
that you want to optimize. 

For example, “SDNTRUN.EXE D: E:” runs Norton Speed Disk on drives 
D and E.
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Can Norton Speed Disk optimize a drive offline?

Unlike other defragmentation programs, Norton Speed Disk can 
completely optimize a drive online. It is no longer necessary to optimize 
drives offline. 
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S U P P O R T

Service and support solutions

Service and support information is available from the Help system of your 
Symantec product. Click the Service and Support topic in the Help index.

Technical support
Symantec offers several technical support options:

� StandardCare support

Connect to the Symantec Service & Support Web site at 
http://service.symantec.com, then select your product and version. 
This gives you access to product knowledge bases, interactive 
troubleshooter, Frequently Asked Questions (FAQs), and more.

� PriorityCare, GoldCare, and PlatinumCare support

Fee-based telephone support services are available to all registered 
customers. For complete information, please call our automated fax 
retrieval service at (800) 554-4403 and request document 933000.

For telephone support information, connect to 
http://service.symantec.com, select your product and version, and 
click Contact Customer Support.

� Automated fax retrieval

Use your fax machine to receive general product information, fact 
sheets, and product upgrade order forms by calling (800) 554-4403. For 
technical application notes, call (541) 984-2490.
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Support for old and discontinued versions

When a new version of this software is released, registered users will 
receive upgrade information in the mail. Telephone support will be 
provided for the old version for six months after the release of the new 
version. Technical information may still be available through the Service & 
Support Web site (http://service.symantec.com).

When Symantec announces that a product will no longer be marketed or 
sold, telephone support will be discontinued 60 days later. Support will be 
available for discontinued products from the Service & Support Web site 
only.

Customer service
Visit Symantec Customer Service online at http://www.symantec.com/
techsupp/news/custserv.html for assistance with non-technical questions 
and for information on how to do the following:

� Subscribe to the Symantec Support Solution of your choice.

� Obtain product literature or trialware.

� Locate resellers and consultants in your area.

� Replace missing or defective CD-ROMS, disks, manuals, and so on.

� Update your product registration with address or name changes.

� Get order, return, or rebate status information.

� Access customer service FAQs.

� Post a question to a Customer Service representative.

For upgrade orders, visit the online upgrade center at:
http://www.symantec.com/upgrades/ or call the Customer Service Order 
Desk at (800) 568-9501.

Worldwide service and support
Technical support and customer service solutions vary by country. For 
information on Symantec and International Partner locations outside of the 
United States, please contact one of the service and support offices listed 
below, or connect to http://www.symantec.com, select the country you 
want information about, and click Go!
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Service and support offices

North America

Argentina, Chile, and Uruguay

Asia/Pacific Rim

Brazil

Columbia, Venezuela, the Caribbean, and Latin America

Symantec Corporation
175 W. Broadway
Eugene, OR 97401

http://www.symantec.com/
(Fax: (541) 984-8020

Automated Fax Retrieval (800) 554-4403
(541) 984-2490

Symantec Region Sur
Cerrito 1054 - Piso 9
1010 Buenos Aires
Argentina

http://www.symantec.com/region/mx
+54 (11) 4315-0889
Fax: +54 (11) 4314-3434

Symantec Australia Pty. Ltd.
408 Victoria Road
Gladesville, NSW 2111
Australia

http://www.symantec.com/region/reg_ap/
+61 (2) 9850 1000
Fax: +61 (2) 9817 4550

Symantec Brazil
Av. Juruce, 302 - cj 11
São Paulo - SP
04080 011
Brazil

http://www.symantec.com/region/br/
+55 (11) 531-7577
Fax: +55 (11) 5530 8869

Symantec América Latina
2501 Colorado, Suite 300
Santa Monica, CA 90404

http://www.symantec.com/region/mx/
+1 (541) 334-6050 (U.S.A.)
Fax: (541) 984-8020 (U.S.A.)
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Europe, Middle East, and Africa

Mexico

Virus protection subscription policy
If your Symantec product includes virus protection, you might be entitled 
to receive free virus protection updates via LiveUpdate. The length of the 
free subscription could vary by Symantec product.

When you near the end of your virus protection subscription, you will be 
prompted to subscribe when you start LiveUpdate. Simply follow the 
instructions on the screen. After your free subscription ends, you must 
renew your subscription before you can update your virus protection. 
Renewal subscriptions are available for a nominal charge.

To order a subscription, do one of the following:

� Visit our Web site at: http://www.shop.symantec.com.

� Outside the United States, contact your local Symantec office or 
representative.

Every effort has been made to ensure the accuracy of this information. 
However, the information contained herein is subject to change without 
notice. Symantec Corporation reserves the right for such change without 
prior notice.

May 2000

Symantec Customer Service Center
P.O. Box 5689
Dublin 15
Ireland

http://www.symantec.com/region/reg_eu/
+353 (1) 811 8032
Fax: +353 (1) 811 8033

Automated Fax Retrieval +31 (71) 408-3782

Symantec Mexico
Periferico Sur No. 3642, Piso 14
Col. Jardines del Pedregal
09100 Mexico, D.F.

http://www.symantec.com/region/mx
+52 (5) 661-6120; +1 (800) 711-8443
Fax: +52 (5) 661-8819
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fragmentation

analysis 33-37
causes 19
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HPFS partitions 60

I
Install tab settings 51
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most fragmented files

analysis 36
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features 7
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by fragmentation threshold 42, 44
capabilities of Norton Speed Disk 8
concurrent drives 48
customizing each drive 23, 52-54
event logging 48
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volumes 19
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setting optimization priority 46
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Unmovabile Files drive option 54
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